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Introduction 1

1 Introduction

1.1 Document

Version status of this document: 1.0

1.2 General

In this manual you will become familiar with:

The digital amplifier VT-VRPD

The BODAC (Bosch Rexroth Operator interface for Digital Axis Controller) 
software

Application examples

You will learn about the menus and window contents for the software, the settings and 
parameters

The software description presumes basic familiarity with a PC and corresponding 
knowledge of the user interface and operating elements of Windows™

If you need additional information, please read the relevant chapters in the Microsoft 
Windows user’s manual or use Windows online help

Information about installation and operation of the VT-VRPD card can be found in the 
manual “Installation and Operation of the VT-VRPD Controller”

A list of VRPD documentation can be found in the publication RE 30126

1.3 Signs and symbols used in this document

The following signs and symbols are used in this manual

Activity symbol: The text following this sign describes activities. These are to be 
performed from top to bottom in the order indicated.

Result symbol: The text following this sign describes the result of an action.

After this symbol you will find notes and useful tips for optimal usage of 
the controller card.
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Introduction 1

After this symbol you will find references to more detailed 
documentation.

Special safety notes are given at the relevant locations. These are indicated using the 
following symbols

General hazard
This sign is placed in front of activities which represent a 
potential hazard to persons and/or extensive damage to 
equipment

Warning signs
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Overview of the 4WRE 6 and 4WRE 10 – Valve control 2

2 Overview of the 4WRE 6 and 4WRE 10 – Valve control

2.1 General

The digital amplifier VT-VRPD-2-2x is used to control a 4/2- and 4/3-Proportional
Control Valve with electrical feedback of the type 4WRE6 or 4WRE 10.

The control system as a minimum consists of:

Valve  4WRE 6 ...-2X/G24K4/V  or 4WRE 10 ...-2X/G24K4/V

Controller VT-VRPD-2-2x
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2.2 Electrical and hydraulic installation plan

Fig. 1 Block schematic of VT -VRPD card
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Explanation of items 1 – 17:

No. Designation

1 U/U- or I/U-Transformer

2 Adjustment of analog inputs 

3 Switching matrix

4 Power supply unit

5 Binary command value call-ups

6 Binary call-ups control

7 Adjustment of characteristic curve

8 Creator of jump function

9 Offset

10 Limitation

11 PID controller

12 Oscillator/Demodulator

13 Testjacks

14 Digital outputs

15 Fault logic

16 Local Bus

17 Serial interface

Testjacks

X1 Valve current (default)

X2 Valve command (default)

- Reference potential (0V)
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Connector pin assignments

Pin Description VT-VRPD-2-2X

2 DI 1 Command call-up: Binary 1

4 DI 2 Command call-up: Binary 2

6 DI 3 Command call-up: Binary 4

8 DI 4 Command call-up: Binary 8

10 DI 5 n.c.

12 DI 6 DI 1 – 4 valid

14 DI 7 n.c.

16 DI 8 n.c.

18 DI9 Enable

20 DO 1 Solenoid A active

22 OK Ready for operation

24 Data + Local CAN Bus In-/Output

26 DO 2 Solenoid B active

28 Data – Local CAN Bus In-/Output

30 AO 1 Valve command value

32 AO 2 n.c.
Tab. 1 Connector configuration, row d

Pin Description VT-VRPD-2-2X

2 AI3+ n.c.

4 AI3- n.c.

6 AI2+ Ramp+ (current or voltage input)

8 AI2- Ramp+ (current or voltage input)

10 AI1+ n.c.

12 AI1- n.c.

14 AI4+ Command value (as voltage input)

16 AI4- Command value (as voltage input)

18 AI5+ Ramp- (current or voltage input)

20 AI5- Ramp- (current or voltage input)

22 AI6+ Command value (as current input)

24 AI6- Command value (as current input)

26 AO3 Solenoid current

28 AGND Analog GND

30 REF- Reference voltage -10V

32 REF+ Reference voltage  +10V
Tab. 2 Connector configuration, row b

Row d

Row b



Company Registered in England No: 4167649    VAT Registration No: 732 5692 25    BS EN ISO 9001:2008 No: LRQ 0964389

+44 (0)1204 699959
enquiries@hyquip.co.uk

Hyquip Limited   New Brunswick Street   Horwich   Bolton   Lancashire   BL6 7JB   UK

www.hyquip.co.uk/web/index

RE 30126-01-B/08.07 | Manual Hydraulics |  Bosch Rexroth AG 11/76
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Pin Description VT-VRPD-2-2X

2 MA+ Solenoid A+

4 MA – Solenoid A–

6 MB+ Solenoid B+

8 MB – Solenoid B–

10 Shield Shield

12 L1O– LVDT Valve Power –

14 L1I– LVDT Valve actual value –

16 L1I+ LVDT Valve actual value +

18 L1O+ LVDT Valve Power +

20 System ground System ground

22 DO 3 Following error > configured value

24 DO 4 Digital Output, programmable

26 DO 5 Digital Output, programmable

28 DO 6 Digital Output, programmable

30 UB Supply voltage

32 LO Common
Tab. 3 Connector configuration, row z

Pin Description VT-VRPD-2-2X

2 DO 7 n.c.

4 SSI Clk+ n.c.

6 SSI Clk- n.c.

8 SSI Data+ /
INC Ua1

n.c.

10 SSI Data -/
INC /Ua1

n.c.

12 Ua2 n.c.

14 /Ua2 n.c.

16 Ua0 n.c.

18 /Ua0 n.c.

20 L2O- n.c.

22 L2I- n.c.

24 L2I+ n.c.

26 L2O+ n.c.

28 GND_CAN n.c.

30 CANL n.c.

32 CANH n.c.
Tab. 4 Connector configuration, row f

Row z

Row f
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Connecting the proportional valve

When connecting the proportional valve, be sure that the solenoid cables are routed 
separately from the inductive position transducers.

It is strongly recommended that the solenoid cable is shielded.

For lengths up to 50 m cable 2 x 1.5 mm² of type LiYCY-CY (16 AWG double-shielded
cable) is  recommended. When double shielded cable is used the outer shield can be 
terminated entering the control cabinet and the inner shield needs to be terminated at 
the controller card.

VPCD_05

2

PE

12

PE

1

Solenoid a Solenoid b

Solenoid connector wiring

to Controller to Controller

z2 z4 z6 z8z10

Fig. 2 Connecting the solenoids

A CECc 75301-803-A002FA-H3008-G cable connector according to DIN EN 175 301-
803 and ISO 4400 is recommended for connecting the solenoids.

Solenoid a, cable connector color gray

Order separately under material number R901017010

Solenoid b, cable connector color black

Order separately under material number R901017011

Single-solenoid valves are to be connected to solenoid A+/A-. The 
solenoid B+/B- connection then remains open. For single-solenoid
valves, only positive command values are recognized as being valid.

When using single-solenoid valves in conjunction with current input 
b22/b24, it must be noted that range +/-100% is set as default setting.
To be able to utilize the full range 0…20mA, range 0~100% must be
set.
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Connecting the valve position transducer

Connection for the valve position transducer is shown in the following illustration.

VPC D_06

3
4 2
1

Valve position feedback connection

z12
z14

z16
z18

z10

Fig. 3 Connecting the valve transducer

The transducer is connected using a 4-pole cable connector Pg7-G5W1F, which can 
be ordered separately under material number R900023126.

Cable 4 x 0.25 mm² of type LiYCY-CY ( 4 x 30 AWG Double shielded cable) is 
recommended for lengths up to 50 m.

The shield should be connected to z10 on the edge connector of the controller on the 
supply side only.
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2.3 Controller faceplate elements

Fig. 4 Faceplate elements

The LED indicates the status of the controller card.

OK “Ready”

“Enable“ (d18) active

The controller cards software is configured using the serial port. The following graphic 
shows the pin configuration for the D-SUB female on the front panel.

Status-LED

Serial port
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D-SUB

1
6

9

Receive data (RS232)

Transmit data (RS232)

GND5

Fig. 5 Terminal assignments for the D-SUB socket

When an input or output is active the corresponding LED is illuminated.

LED Description VT-VRPD-1-1X

I1 DI 1 Binary Command-Setpoint 1

I2 DI 2 Binary Command-Setpoint 2

I3 DI 3 Binary Command-Setpoint 4

I4 DI 4 Binary Command-Setpoint 8

I5 DI 5 n. c.

I6 DI 6 Command-Setpoint 1-4 valid

I7 - n. c.

O1 DO 1 Solenoid A active

O2 DO 2 Solenoid B active

O3 DO 3 Following error > configured value

O4 DO 4 Digital Output, programmable

O5 DO 5 Digital Output, programmable

O6 DO 6 Digital Output, programmable

O7 - n. c.

Tab. 5 LEDs on front panel

The test jacks can be used to access variable control signals.

X1 Test jack 1 (Output A03)

X2 Test jack 2

Test jack GND

LEDs Inputs / 
Outputs

Test jacks
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3 Application: Valve control for the 4WRE6 / 4WRE10

3.1 Structured list for proceeding with startup

The BODAC Software

Data interchange between BODCA software and the controller card VT-VRPD

Opening or creating Parameters

Configure inputs

Setpoint using a voltage input
Setpoint using a current input
Ramp + (increasing)
Ramp - (decreasing)
Configure analog inputs

Configure Profile

Configure structure
Setpoint configuration
Faults

Store parameter values

Check Process settings

Motion Data
Status
Testjacks

Start the Application

Using software for startup

Configure inputs

Define structure

Store current status

Process settings

Starting the application
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Application: Valve control for the 4WRE6 / 4WRE10 3

3.2 Data exchange between the BODAC software and the VT-VRPD
controller card

Establish an RS-232 connection between the PC and the VT-VRPD so that you can 
configure, save and duplicate the desired data for your controller card.

The baud rate (57600 baud) is fixed in the card.

Connect PC to VT-VRPD using an RS-232 cable (1:1 cable)
e.g. cable set: VT-HACD-1x/03.0/HACD-PC, Material-No. R900776897, 
length 3 m
Turn on PC and VT-VRPD

Install BODAC.

Start BODAC (see section 4 “BODAC user interface”).

USB converter:

If the PC has no serial port, an USB/RS232 interface converter may be 
used. (Can be ordered using material number R901066684.)

3.3 Open or create parameter file

The card is configured depending on the application. The data for configuration and 
parameterisation are saved in a file (FILENAME.PARAM) and stored in the predefined 
directory \user\.

Assign a file name and save the beginning state.

If there are no param eter files, you are prompted after program start to 
open a default file.

See section “Open”.

See section “Save”.

Open parameter file

Create parameter file
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3.4 Configure inputs

The “Analog I/O” menu is where you configure the analog inputs for your application.

Clicking on the preceding icon, which is a component of the toolbar, 
also opens the “Analog I/O” window. A list of existing shortcuts for the 
toolbar can be found in Section 4.2 “BODAC Toolbar”.

Fig. 6 “Analog I/O" window

The File menu in the “Analog I/O” window corresponds to the BODAC main window 
“File menu”.

Contains commands for reading, writing and modifying parameters.

Takes you directly to the help for the current topic, or to the contents page of the 
BODAC windows help.

NOTES:

Note that set external command values  are added to the internal 
command values of the profiles. If the external command value is 
turned off, only the parameterized internal set point always remains as 
the input for the controller.

The analog inputs are all differential inputs.
Note:
If the differential inputs are used both connections of the differential
input have to be switched ON or OFF simultaneously.
Contacts used for this have to be suitable for currents< 1mA.

Voltage (b14/b16)

Here the range for the external setpoint (Voltage input b14/b16) is defined.

Analog I/O -
File menu

Analog I/O -
Controller menu

Analog I/O -
Help menu
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Application: Valve control for the 4WRE6 / 4WRE10 3

By using the mouse to click on the „Type“ field a pull-down menu will open from which 
the following options can be selected:

+/-10 V 
The input signal has a range of (–10 V) to (+10 V).

0~10 V
The input signal range is from  (0 V) to (+10 V).

Further adjustment to the input signals is explained in greater detail in the section 
“Configure Analog I/O - Inputs“.

Current (b22/b24)

The range for the external setpoint using the Current input (b22/b24) is configured for
4-20 mA and can not be changed.

Further adjustment to the input signals is explained in greater detail in the section 
“Configure Analog I/O - Inputs“.

Ramp+ (b6/b8)

This value determines the external ramp used to ramp the command signal when the 
setpoint is a rising edge in positive (Solenoid A) or negative (Solenoid B) direction.

Clicking on the „TYPE“ entry field opens a pulldown menu containing the following:

0~10 V 
An input signal of (0 V) to (+10 V) is expected.

4~20 mA
The current value of the input signal ranges from (4 mA) to (20 mA).

For additional configuration of the Ramp+ please refer to Section “Configure Profile”

Ramp- (b18/b20)

This value determines the external ramp used to ramp the command s ignal when the 
setpoint is a falling edge in positive (Solenoid A) or negative (Solenoid B) direction.

Clicking on the „TYPE“ entry field opens a pulldown menu containing the following:

0~10 V 
An input signal of (0 V) to (+10 V) is expected.

4~20 mA
The current value of the input signal ranges from (4 mA) to (20 mA).

For additional configuration of the Ramp- please refer to Section “Configure Profile”

Type

Type

Type

Type
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Configure Analog I/O - Inputs

The following parameters can be used to configure the Analog I/O – Inputs:

The value range of the signal in [%] is set in the „Range“ column. If the selection +/-
10V is made in the „Type“ column a signal of (-10V) corresponds to a signal of (-
100%) when the range setting is +/-100%.

The „Min“ value sets the minimum fort he input signal. Depending on the setting of 
„Type“ and „Range“ this value is translated to the minimum value of the „Range“ 
setting.

If for example you enter -5V , with Type = +/-10V and Range = +/- 100%, a signal of -
5V is interpreted as -100%.

The „Max“ setting is the opposite of the „Min“. If +9V is entered a signal of +9V is 
interpreted as 100%.

If the value falls below the entered value, BODAC uses the „Status“ window and the 
„Status bar“ to indicate that a fault has occurred. Specifying the error response is 
done in the “Faults” window.

If the value exceeds the entered value, BODAC uses the „Status“ window and the 
„Status bar“ to indicate that a fault has occured. Specifying the error response is done 
in the “Faults ” window.

The „max Unit“ specifies the conversion from Range [%] to Units [Unit].

Fields that can not be modified are grayed-out.

Range

Min

Max

min Fault

max Fault

max Unit
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3.5 Configure Profile

Configure Strucure

This window is us ed to configure which inputs and/or components are going to be 
active.

Clicking on the preceding icon, which is part of the toolbar, also opens 
the window „Structure“. A list of existing icons for the toolbar can be 
found in section 4.2 „BODAC Toolbar“.

Fig. 7 „Struc ture“ window

The File menu in the “Structure” window corresponds  to the BODAC main window 
“File menu”.

Contains commands for reading, writing and modifying parameters .

Takes you directly to help for the current topic, or to the contents page of the BODAC 
windows help.

Activates / De-activates the positive external Ramp.

Activates / De-activates the negative external Ramp.

Here the user can select the external setpoint (Voltage, Current or OFF) and polarity.

The valve to be controlled with this card has to be selected in this window. Choosing a 
valve defines the default values for the valve parameters .

Structure - File menu

Structure - Controller menu

Structure - Help menu

Ext. Ramp +

Ext. Ramp -

External CMD

Valve controller
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Apart from the pull down menu’s in the „Structure“ window there are also several 
buttons that will lead to seperate windows when selected clicking on it:

Clicking on this button opens the window „Commands“. See also 
"Commands "

Clicking on this button opens the window „Commands“. See also 
"Commands "

Clicking on this button opens the window „Analog I/O“. See also
„Configure Analog I/O - Inputs“.

Clicking on this button opens the window „Command Adjustment“.
See also „Valve Configuration“

Commands

In order to have a smooth control Step changes of the command should be avoided. 
For this purpose there are parameters available to shape the command signal before 
it enters the control portion of the controller.

To create a command the user has the ramp parameters to manipulate this command. 
The configured ramp time always reflects the time it takes to reach the Command of a
100%. E.g. if the Command changes from 0% to 50 % it will take half the time 
configured in the Ramp time.

In this window you set the digital selected commands as well as the Ramps and S-
Ramps .

Clicking on the preceding icon, which is a component of the toolbar, 
also opens the „Commands“ window. A listing of existing shortcuts for 
the toolbar can be found in Section 4.2 „BODAC Toolbar“.

Ramp

Commands
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Fig. 8 Window „Commands“

Corresponds to the BODAC main window „File menu“.

Contains commands for reading, writing and modifying parameters.

Takes you directly to the help for the current topic, or the contents page of the 
BODAC windows help.

Up to 16 separate setpoints can be selected using the digital inputs. The different 
parameters for these digital setpoints are configured in this window:

Command (-100 … +100 %)

Ramp time for rising flank (0.01 ... 300 s)

Ramp time for falling flank (0.01 ... 300 s)

S-Ramp for rising flank

S-Ramp for falling flank

The selected digital setpoint is added to the external CMD as can be 
seen in Fig. 8 “Structure” window.

The digital input DI6 sets the binary word as valid. Only if this input is High the 
patterns for inputs DI1 to DI5 are accepted. The current state remains valid until there 
is a state change.

Commands –
File Menu

Commands –
Controller menu

Commands –
Help menu

Digital Setpoints

Binary enable
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In the motion data screen inputs DI1 to DI5 are only updated if DI6 
shows a High level.

The active block can be calculated according to the following:

Active block = 8*DI4 + 4*DI3 + 2*DI2 + 1*DI1

where  DIx = 0 if input shows a Low level (0V)

  DIx = 1 if input shows a High level (24V).

The following shows the relationships of the digital inputs in a truth table.

Active Block DI4
Binary 8

DI3
Binary4

DI2
Binary 2

DI1
Binary 1

0 0 0 0 0

1 0 0 0 1

2 0 0 1 0

3 0 0 1 1

4 0 1 0 0

5 0 1 0 1

6 0 1 1 0

7 0 1 1 1

… … … … …

12 1 1 0 0

13 1 1 0 1

14 1 1 1 0

15 1 1 1 1

The blocks are activated by the high end controller (SPS / PLC) according to the table 
shown using the digital inputs.

An overview of the connected signals to the controller and active block 
can be found in the „Motion data“ window described in the Section 
“Testing the application settings„.
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Faults

In the „Faults“ window the fault behavior of the VRPD is configured.

Clicking on the preceding icon, which is a component of the toolbar 
and only accessible at level 2, also opens the :Faults“ window. A list of 
existing shortcuts for the toolbar ca be found in Section 4.2 „BODAC
Toolbar“.

Fig. 9 Window „Faults““

Corresponds to the BODAC main window “File menu”.

Contains commands for reading, writing and modifying parameters .

Takes you directly to the help for the current topic, or to the contents page of the 
BODAC windows help. 

In the Faults window the response of the VRPD Control Card for various monitoring 
settings is specified:

STOP
The VRPD stops  the controller and the current output to the solenoids is set to 
zero. A specific error message is not possible. The PLC recognizes the fault
condition by the „OK“ signal being low.

ERROR
The VRPD sets a flag and in the „Status“ window indicating that a Fault has 
occured. In the “Digital I/O” window a digital output can be configured to signal the 
combined error “Analog I/O Fault”. This combined error indicates that one of the 
analog inputs exceeds the Min Fault or Max Fault setting.

OFF
The controller card does not register a fault and there is no error response.

For every Fault the user can configure a debounce time.

Faults –
File menu

Faults –
Controller menu

Faults –
Help menu

Faults

Debounce
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3.6 Valve configuration

Command Adjustment

In this window the controller can be optimized to the applied valve by adjusting the 
command for the characteristic properties of this valve.

Clicking on the preceding icon, which is a component of the toolbar
also opens the “Command Adjustment“ window. A list of existing 
shortcuts for the toolbar can be found in Section 4.2 „BODAC Toolbar“.

Fig. 10 „Command Adjustment“ window

The File menu in the „Command Adjustment“ window corresponds to the BODAC 
main window „File menu“.

Contains commands for reading, writing and changing parameters.

Takes you directly to the help function for the current topic, or to the contents page of 
BODAC windows help.

NOTES:

You can adapt the controller setting to the relevant valve by selecting the 
valve in the “Structure“ window. Please note also that the valve 
param eters shown are only updated after you transmitted the valve 
selection (i.e. the valve selection is displayed in blue).

In the offline mode, always the same standard parameter set is 
displayed. If you wish to view the parameter set of the selected valve, 
you have to be online.

Command Adjustment –
File menu

Command Adjustment –
Controller menu

Command Adjustment –
Help menu
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A curve correction can be applied to the Command. We can use either a parameter 
called „Gamma“ (Type 1) or linearization table (Type 2). Fig. 12 shows the window if 2 
is selected from the pull down menu „Type“.

Fig. 11 „Command Adjustment“ window with Cureve correction Type 2

The Curve correction entry field Type 1 („Gamma“) is used to correct a non linear 
curve of the valve. The values for “Gamma” lie between 0 and 100, whereby a setting 
of 100 does not affect the variable and 0 represents the maximum adjustment.

In the following example („Plot Gamma“), 3 curves are shown. The blue curve “LO1” 
represents a Gamma entered value of 100, the brown curve „OUT2“ is set to the 
Gamma entered value 90, and the red curve “OUT1” has a Gamma value of 50.

Curve correction

Curve correction – Type 1
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Fig. 12 Plot - Gamma

If Type 2 is selected for the Curve correction linearization of the valve can be 
achieved by entering individual value pairs.

Overlap compensation is used for linearizing of valves with a positive overlap. This will 
correct the control value (valve setpoint). The value in the entryfield Step +/Step – is 
added to the control value. The step can be specified differently depending on the 
sign of the control value. 

If this control value lies within the „Deadband“ a value is output which closes the 
overlapped valve in defined fashion if Step +/Step – has been correctly selected.

The result for the following settings is shown in the illustration below:

Step+ = 30%,
Step- = 20% and
Deadband = 10%.

The time base is set to 500ms.

Curve correction – Type 2

Overlap
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Fig. 13 Plot – Overlap

The parameter in the „Offset“ entry field shifts the variable by the entered value.

In the fields „Limit +“ and „Limit –„ the positive an dnegative maximum value allowable 
is specified.

Configure

the zero adjustment of the connected valve can be configured.

Clicking on the preceding icon, which is a component of the and only 
accessible at level 2, also opens the “Configure“ window. A list of 
existing shortcuts for the toolbar can be found in Section 4.2 „BODAC
Toolbar“.

Fig. 14 „Configure“ window

Corresponds to the BODAC main window „File menu“.

Offset

Limit

Configure –
File menu
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Contains commands for reading, writing and modifying parameters.

Takes you directly to the help fort he current topic, or to the contents page of the 
windows help.

In this window the zeropoint of the feedback LVDT is adjusted. The range for the 
zeropoint valve is from (-100) to (+100).

Here is how the zeropoint valve is adjusted:

Set Enable and apply a command of 0%

Change the value of „Zeropoint valve“ until the feedback LVDT = 0%.

3.7 Save parameters

All parameters for all functions are set.

Save all the parameters in a file (FILENAME.PARAM). The parameter file is 
stored in the directory \user\.

See also Section „Save“.

3.8 Testing the application settings 

With the Enable High you can get a quick overview of the current state of the 
controller through:

The current signals  („Motion data“ window)

Any present failures („Status“ window)

The hardware/software status  of the controller card („Card information“ window)

If certain signals need to be externally available (e.g. for monitoring on a oscilloscope)
the Test jacks can be used as the external interface.

Motion data

This window shows the links between the individual process variables and the current 
values as well as the signal states.

Clicking on the preceding icon, which is a component of the toolbar, 
also opens the “Process display” window. A list of existing shortcuts for 
the toolbar can be found in Section 4.2 “BODAC Toolbar”.

Configure –
Controller menu

Configure –
Help menu

Zero Adjustment
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Fig. 15 “Motion Data” window

In the upper section the actual state of the VRPD is displayed with the parameter 
“Binary call”. If the Enable is set but the Binary valid signal is low Block 0 is called 
regardless of the binary inputs setting. 

The signals displayed in the middle portion of this window are the actual values of the 
signals in the “Structure” window.

In the bottom part of the window the Digital inputs and outputs  status is displayed 
using ON/OFF.

Corresponds to the BODAC main window „File menu“.

Contains commands for reading, writing and modifying parameters.

Takes you directly to the help for the current topic, or to the contents page of the 
BODAC windows help.

Clicking on the oscilloscope symbol in the toolbar opens the BODAC 
window “Multiplot”. For more information see also Section “Multiplot”.

The Data Log symbol in the toolbar generates a file with the extension 
“.log” in which all motion data are stored. For more information see
also Section “Creating a log file“.

Selecting a signal for graphical representation is done by clicking on that signal in the 
„Motion data“ window. Deselecting a signal is done by clicking on this signal a second 
time. When all the signals are marked the „multiplot“ window can be opened by 
clicking on the „Multiplot“ icon in the toolbar. For more information see also Section 
“Multiplot”.

Motion data –
File menu

Motion data –
Controller menu

Motion data –
Help menu

Motion data –
Toolbar

Motion data
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Status

The „Status“ window provides an overview of the current faults that were detected 
while the controller card was running.

Clicking on the preceding icon, which i spart of the toolbar, also opens 
the „Status“ window. A listing of existing shortcuts for the toolbar can 
be found in Section 4.2 “BODAC Toolbar“.

Fig. 16 Window „Status“

The signals monitored can have the following status:

OK
No faults .

ERROR
A Fault was detected. This Fault was configured as a „ERROR“ in the „Fault“ 
window resulting in the detection of the Fault but not switching off the controller. 
Not every Fault can be configured as a “ERROR”. See also Section “Faults”.

STOP
A Fault was detected. This Fault was configured as a „STOP“ in the „Fault“ 
window resulting in switching off the controller. See also Section “Faults”.

Test jacks

In this window you can configure the test jacks: You specify which control parameter 
is available on the test points.

Status
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Clicking on the preceding icon, which is a component of the toolbar, 
also opens the “Test points” window. A list of existing shortcuts for the 
toolbar can be found in Section 4.2 “BODAC Toolbar”.

Fig. 17 “Test jacks” window

The File menu in the “Test jacks” window corresponds to the BODAC main window 
“File menu”.

The Controller menu contains commands for reading, writing and modifying 
param eters.

The Help menu takes you directly to the help for the current topic, or to the contents 
page of the BODAC windows help.

Test jack X1 is permanently set to the actual value „LVDT“. X2 can be configured as 
the command before the Command Adjustment (LC1) or the Command after the 
Command Adjustment (OUT1).

3.9 Start Application

The application is started by setting the digital input „Enable“ (d18).

See also "Electric and Hydraulic Installation plan"

Test jacks -
File menu

Test jacks -
Controller menu

Test jacks -
Help menu

Test jacks

Start-up
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4 User interface BODAC - General

4.1 Software tool and data handling

The BODAC Software

BODAC is a software tool for start-up. It must be installed on the PC or laptop you are 
using for the initial startup.

BODAC stands for:

Bosch Rexroth Operator interface for Digital Axis Controller for in- and output 
configuration, controller structure configuration, parameterisation, motion data and 
diagnostics.

This software tool can be downloaded from the Internet at 
http://www.boschrexroth.com/hacd.

Data exchange between BODAC and the VRPD

Establish a connection between the PC and the VT-VRPD so that you can set, save 
and duplicate the desired data.

The connection is based on RS232. A fixed baud rate is set in the card (57600 baud).
Use an RS232 cable (1:1 cable) to connect the PC to the VRPD.
Turn on PC and VRPD.
Install BODAC.
Start BODAC (see document RE 30126-B)
BODAC automatically uploads the parameter set from the VRPD.

If BODAC does not upload automatically, no connection was made. In 
this case check the “Configuration of the serial interface”, the serial 
connection and the supply voltage.

Create file

It is recommended that the parameter set be saved in a file. This allows you to restore 
the current status of the VRPD at any time.

Assign a file name and save the initial param eter settings.
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Save the current status

This allows you to easily store all parameters and structure specifications during 
startup. If your work is interrupted, you can resume later without any loss of data.

To finalize your work, save the data also in the permanent memory 
(flash) of the VRPD card.

See also: “Save”.

See also: “Set parameters to memory”

4.2 Main Menu

These include:
The title bar

The menu bar

The toolbar

The status bar

Fig. 18 BODAC main menu
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Title bar

The title bar contains the name of the program/window and several standard Windows 
buttons. Information about the standard Windows buttons can be found in your 
Windows online help.

Menu bar

The menu bar lists all the menus and commands available in BODAC.

The following menus are available:
File menu

Controller menu

View menu

Configuration menu

Options menu

Application Window menu

Windows menu

Help menu

BODAC toolbar

The toolbar contains buttons with symbols (icons) execute the most commonly used 
functions, invoke commands or open windows when clicked on with the mouse.

Following is a list of the available functions:

Generates the “Offline” command, which breaks the connection to the 
controller card. The symbol is only visible if there is an active connection to 
the card.
Generates the “Connect” command. The symbol is only visible if there is no 
active connection to the card.

Opens the “Open” window, where you can select stored BODAC data files.

Opens the “Save file as” window, in which you can save your entries.

Opens the "Analog in-/outputs“ (“Analog I/O”) window.

Opens the "Status“ window.
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The “Read parameters” command reads the data (parameter set) stored in 
the working memory of the VRPD and passes the set to the BODAC 
program.
The “Write parameters” command sends the current data (parameter set) 
from BODAC to the working memory of the VRPD.

The “Set parameters to memory” sends the VRPD parameter set from 
working memory to permanent memory.

Opens the "Language“ window.

Opens the "Print forms“ window.

Opens the "Structure“ window.

Opens the "Command Adjustment“ window.

Opens the "Command values“ window.

Opens the "Digital I/O“ window.

Opens the " Motion Data“ window.

Opens the "Test jacks“ window.

Window toolbar

The Window toolbar contains buttons with symbols (icons) execute the most 
commonly used functions, invoke commands or open windows when clicked on with 
the mouse.

Following is a list of the available functions:

see 4.2 “Read Parameters”

see 4.2 “Write Parameters”

Clicking on this symbol writes only the parameter value you have just 
changed to the card.

The “Set parameters to memory” sends the current data from BODAC 
to the memory chip of the controller card.
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If you are in an entry field, you can click on the symbol “+” to increment 
the field contents. Simultaneously BODAC writes this parameter to the 
card.

Exception: Multiplot, see “Multiplot toolbar”

If you are in an entry field, you can click on the "-" symbol to 
decrement the field contents. Simultaneously BODAC writes this 
parameter to the card.

Exception: Multiplot, see “Multiplot toolbar”

The Undo symbol in the toolbar nullifies the last entry.

Clicking on the oscilloscope symbol in the toolbar opens the BODAC 
window “Multiplot”.

To show signals in the Multiplot window, open the Motion Data window 
and click on the name of the desired signal. The name of the signal is 
highlighted in red to indicate that it is selected for display in the 
Multiplot window. Then click on the oscilloscope symbol in the toolbar 
to open the Multiplot window. The signals you selected will be 
displayed.

You can also select more signals once the "Multiplot" window is 
opened.

A maximum of 8 signals can be selected.

Clicking on the printer symbol in the toolbar opens the Windows 
system window “Print”.

The Help symbol in the toolbar generates a help pointer. Clicking with 
the help pointer on a parameter field opens the help for this parameter 
field.
The Data Log symbol in the toolbar generates a file with the extension 
“.log” in which all motion data are stored.

Status bar

The status bar contains useful information about the active window. For example the 
main menu shows the current connection status.

Short cut list

You can also invoke important functions using the function keys on the keyboard. The 
function keys are defined as follows:

F1 Opens BODAC Help (see also “Help menu”)

F2
Reads the currently saved data in the controller card and sends them 
to the BODAC program. (see also “Read Parameters”)
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F3 Sends the settings and entries you made to the card and overwrites 
the previously saved data in volatile memory. (see also “Write 
Param eters”)

F11 If you are in an entry field, you can press “F11” to increment the field 
contents. Simultaneously BODAC writes this parameter to the card.

F12 If you are in an entry field, you can press “F12” to decrement the field 
contents. Simultaneously BODAC writes this parameter to the card.

Page-
down

If you are in the structure editor in the entry field block, you can use 
“Page down” to increment the field contents. This then opens the next 
higher block.

Page-
up

If you are in the structure editor in the entry field block, you can use 
“Page up” to decrement the field contents. This then opens the next 
lower block.
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5 BODAC – Menu Description

5.1 File menu

The “File” menu contains commands for administering and printing data.

Fig. 19 “File” menu

Open

Opens a window in which you can load the complete parameter structure that you 
previously created and saved in BODAC. The profile contains all the values and 
parameters you specified and entered before saving in BODAC.

Clicking on the preceding icon, which is a component of the toolbar, 
also opens the window in which you can select the saved data files. A 
list of existing shortcuts for the toolbar can be found in Section 4.2 
“BODAC Toolbar”.

Save

Opens a window in which you can save all the data you entered and specified while 
working with BODAC under a file name of your choice. This creates a file you can use 
to send the functionality of this card to additional cards. The file has a “.param” 
extension.

Clicking on the preceding icon, which is a component of the toolbar, 
also opens the window in which you can save your entries. A list of 
existing shortcuts for the toolbar can be found in Section 4.2 “BODAC 
Toolbar”.
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Save the complete parameter structure after installation is complete! 
When replacing a defective card you can transfer the existing 
param eter structure to the new card. This card is then immediately 
ready for use with all previously defined parameters and value 
settings. You can also send already defined parameter structures to 
comparable or similar applications.

Printer Setup

This menu point opens the standard Windows “Printer Setup" window. Information 
about setting up a printer can be found in your Windows online help.

Print

This menu point first opens the “Print” window as shown in the following illustration.

Fig. 20 “Print” window

The window is divided into several columns. In the Print column you select the data 
sheet you want to print. If more than one data sheet is available for a form, select the 
number of data sheets to print under Options.

Clicking on the preceding icon, which is a component of the toolbar, 
also opens the “Print” window. A list of existing shortcuts for the toolbar 
can be found in Section 4.2 “BODAC Toolbar”.
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Clicking on the “Print” button takes you to the standard “Print” window of Windows. 
Information about the Print window can be found in your Windows online help.

Quit

Closes  all currently opened windows and quits the BODAC program.

5.2 Controller menu

The “Controller” menu contains commands for direct communication with the card. 
These commands are used to send or receive data to and from the card.

Fig. 21 “Controller” menu

Offline

Closes the connection to the card. The “Offline” command is only selectable if there is 
an active connection to the controller card.

Clicking on the preceding icon, which is a component of the toolbar, 
also generates the “Offline” command. The symbol is only visible if 
there is no currently active connection to the card. A list of existing 
shortcuts for the toolbar can be found in Section 4.2 “BODAC Toolbar”.

Connect

Opens the connection between BODAC and the VRPD. The “Connect” command is 
only selectable if there is no active connection to the card.
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Clicking on the preceding icon, which is a component of the toolbar, 
also generates the “Connect” command. The symbol is only visible if 
there is no currently active connection to the card. A list of existing 
shortcuts for the toolbar can be found in Section 4.2 “BODAC Toolbar”.

Search Card

The command “Search Card” opens the window “Search Card”, searches for active
cards on the local bus and lists them in a tabular form. 

Fig. 22 Window “Search Cards“

Cards are searched for on the local bus.

Bodac connects to the selected card.

Bodac changes over to the offline mode and closes the connection with the active 
card.

The search for cards is interrupted, and Bodac maintains the connection with the 
active card.

In the first column “ID“ the bus address of the card is shown. The master bus address 
is not listed, but must differ from the bus addresses of other cards.

The second column “Mat. Nr.“ includes the material number of the card and the 
version number of the configuration. (see “Card Information“).

The third column “Description“ shows the text presented on the display. This text can 
be changed in the window “Card Information“.

Read parameters

The “Read parameters” command reads the data (parameter set) stored in the 
working memory of the controller card and passes the set to the BODAC program.

Clicking on the preceding icon, which is a component of the toolbar, 
also reads out the data stored in the card and sends them to the 
BODAC program. A list of existing shortcuts for the toolbar can be 
found in Section 4.2 “BODAC Toolbar”.

Start Search

Connect

Offline

Cancel
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Write Parameters

The “Write parameters” command sends the settings and entries you made to the 
controller card and overwrites the previously saved data in volatile memory.

NOTE!

The new data is available as long as the card has power.
If the card is disconnected from its power source, the data will be lost.

To save data permanently on the controller card, read the section “Set parameters to 
memory”.

Clicking on the preceding icon, which is also a component of the 
toolbar, also sends the settings and entries you made to the card and 
overwrites the previously saved data in volatile memory. A list of 
existing shortcuts for the toolbar can be found in Section 4.2 “BODAC 
Toolbar”.

Set parameters to memory

Sends the current data available in BODAC to the cards flash memory. This saves the 
data to the non-volatile memory of the card so it is still available after a power 
interruption.

The preceding icon, which is a component of the toolbar, sends the 
current data from BODAC to the card non-volatile memory. A list of 
existing shortcuts for the toolbar can be found in Section 4.2 “BODAC 
Toolbar”.

Language

The “Language” menu point contains the following options:
English

Deutsch

Clicking on the preceding icon, which is a component of the toolbar, 
opens a selection menu in which you can also select the language. A 
list of existing shortcuts for the toolbar can be found in Section 4.2 
“BODAC Toolbar”.

Displays all the entries, windows, menus, etc. in English.

Displays all the entries, windows, menus, etc. in German.

NOTE!

English

Deutsch
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The software language selection also affects the language version of 
your card.

The menu tree operated by the buttons on the front panel of your card 
is also switched over to the selected language.

The language selection is stored in the card.

Card information

Opens the “Card information” window where all the relevant data for the card are 
displayed.

Fig. 23 “Card information” window

The File menu in the “Card information” window corresponds to the BODAC main 
window “File menu”.

Contains commands for reading, writing and modifying parameters.

Card information –
File menu

Card information –
Controller menu
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Takes you directly to the help for the current topic, or to the contents page of the 
BODAC windows help.

In the upper section of the “Card information” window you will find the manufacturer 
data which provides exact specifications for your controller card.

Keep the following information handy for when you need to contact product support:
Product (contains the unique product number of your card).

Mat.-Nr. (contains  the material number of your card.)

Here the hard- and software used is listed in detail.

In these areas you will find information which exactly specifies your controller card 
hardware. Keep this information handy for when you need to contact product support.

You can enter relevant comments in the entry field, including information pertaining to 
your application or settings.

This field contains a standard text filled in by Bosch Rexroth. The text entered here is 
shown in run mode as a scrolling text on the card display. You can choose to display 
this text, use a text you have entered yourself, or use a signal of your choice.

Have the information in this window ready if you need to contact us.

5.3 View menu

The “View” menu contains the “Status" command you can use to open the "Status" 
window.

Fig. 24 “View” menu

Card information –
Help menu

Versions

Serial number

Comments

Display Text
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Status

This menu item opens the “Status” window, which provides an overview of the current 
faults which were detected while the controller card was operating.

Clicking on the preceding icon, which is a component of the toolbar, 
also opens the “Status” window. A list of existing shortcuts for the 
toolbar can be found in Section 4.2 “BODAC Toolbar”.

Fig. 25 “Status” window

Remains green as long as no fault has been detected.

Remains yellow when a fault has been detected. If a signal you want to monitor is set 
to “Flag” in the “Faults” window, operation of the card is not interrupted. The fault is 
recognized, saved and processing continues.

Lights up red when a fault has been detected. The controller card stops the process.
Set the monitored signal in the “Faults” window to “Stop”.

A fault is generated if the connected signal is outside the pre defined range. The 
range fort he connected signals is defined in the Analog I/O window using „Min Fault“ 
and „Max Fault“.

A fault is indicated if there is a cable break or short circuit on the LVDT transducer for 
the proportional valve.

The Control error is larger than the WINDOW specified in the „Digital I/O“ window 
under Control error.

A fault is indicated if there is a short circuit on the proportional valve solenoid.

The checksum for the memory chip shows a deviation from the currently stored data 
in the chip.

Error indication that the RAM chip in the controller card is defective.

An error is indicated if the supply voltage is absent or incorrect. (short circuit or 
overload caused by other connected consumers)

OK

Fault

STOP

Voltage, Current, 
Ramp+, Ramp-

LVDT secondary,  LVDT primary

Control error

Short circuit SOL a+b

Checksum memory

memory

24V power
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A fault is indicated if the reference voltage +/-10 V on the edge connector deviates by 
0.5 %.

Error indication for digital outputs 1 through 7 when there is a short circuit on one of 
the outputs.

Takes you directly to the help for the current topic, or to the contents page of the 
BODAC windows help.

Fault History

The window “Fault History” provides an overview of the last 16 faults occurred. 

Fig. 26 “Fault History” window

Listing of the fault in clear text. The texts correspond to the fault texts in the “Status” 
window

Time when the fault was recognized. The timer starts when the enable is set and 
stops when the enable is reset.

Time, when the rectification of the fault was recognized. In this case, the enable must 
be set.

The timer runs only when the enable is set. 
Errors are only recognized while the enable is set.

+/-10V Reference

Short circuit DO1 to DO7

Status –
Help menu

Description

Fault Time 

AckTime
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5.4 Configuration menu

The “Configuration” menu contains the “Analog I/O” command which you use to open 
the window for configuring the analog inputs of the controller card.

Fig. 27 “Configuration” menu

Analog I/O

The “Analog I/O” window is where you make the settings for all analog inputs on the 
card.

Clicking on the preceding icon, which is a component of the toolbar, 
also opens the “Analog I/O” window. A list of existing shortcuts for the 
toolbar can be found in Section 4.2 “BODAC Toolbar”.

Fig. 27 “Analog I/O" window

“Inputs” field

The first column in the Inputs field lists the names of the analog inputs.

In the following columns the parameter values for the analog input signals are 
specified.

The Voltage input (b14/b16) can not be configured as Current.
The Current input (b24/b26) can not be configured as Voltage.
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Assignments are made with the mouse button. Clicking on the “Type" entry field 
opens a selection field containing the following:

+/-10 V 
The expected input signal varies in a range of (–10 V) to (+10 V).
0~10 V 
An input signal of from (0 V) to (+10 V) is expected.
4~20 mA
The current level of the input signal varies between (4 mA) and (20 mA).

The “Range” column is where you enter the signal value range in [%]. A signal of (-
10V) for a range setting of ±100% corresponds to a signal of (-100%).

The relationship is shown in the graphic below

The “Min” setting is used to limit the minimum input signal to a value you determine 
within the type range (±10 V). For example, a value of (-5 V) means the signal (-5 V) is 
interpreted as (-100%) range (see Fig. 41 Analog I/O - Input adjustments).

The “Max” setting is the opposite of “Min”. For example, a value of (+9 V) means the 
signal (+9 V) is interpreted as (+100%) range (see Fig. 41 Analog I/O - Input 
adjus tments).

The setting for the value “Min Error” is used to specify the minimum error. When the 
signal falls below this entered value, BODAC uses the “Status” window to indicate that 
a fault has occurred if the fault is activated in the “Faults” window.

The setting for the value „Max Error” is used to specify the maximum error. When the 
signal exceeds this entered value, BODAC uses the “Status” window to indicate that a 
fault has occurred if the fault is activated in the “Faults” window.

The “Max Units” setting specifies the value range of the signal in units [Unit].

The following example shows in table and graphic form the parameters for a signal 
adjustment in the Inputs field.

Max Unit
[Units]

-Min [V]

100

Max Unit
[Units ]

-100

-5 9
Max [V]

100

-100

-10 10

Max [V]

Min [V]

-5

-100 100

9

analoge_ea_diag

Fig. 28 Analog I/O input adjustments

Type

Range

Min

Max

Min fault

Max fault

Max unit
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Local Bus

In the window “LocalBus Hardware”, you can set the bus address of the amplifier card 
for the local bus. 
The local bus is used to connect the individual amplifier cards of the HACD family.

Fig. 29 Window "LocalBus Hardware"

The File menu in the window “Local Bus” corresponds to the BODAC main window 
“File” menu.

 Contains commands for reading, writing and modifying param eters.

Takes you directly to the help for the current topic or to the contents page of the
BODAC windows help.

Buttons are provided for frequently used functions. They are described in "Toolbar of 
a window".

Up to 32 cards can be connected. Each amplifier must be assigned a clear bus 
address.
The connection is established using a CAN protocol with a baud rate of 250kbit. The 
maximum length of the most distant amplifier cards must not exceed 280m. Moreover, 
the maximum length of the branch lines of 1 m must be observed.

Local Bus –
File menu

Local Bus –
 Controller menu

Local Bus –
Help menu

Local Bus –
Toolbar
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Fig. 30 Schematic structure of “Local Bus“

Data is to be transmitted via a shielded twisted-pair cable.

Two bus terminating resistors of 120 Ohm are required.
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5.5 Tools menu

In the “Tools” menu you adjust the settings of the BODAC program for communication 
with the card to your special needs.

Fig. 31 “Tools” menu

In the submenu “Preferences” you change the parameters for the communications 
interface between PC and controller card, the access rights and the behavior for data 
synchronization with the card. The submenu “Utilities” contains update functions  and a 
function for resetting the card to its default settings.

Preferences

Com

The “COM“ window is the dialog window for configuring the serial port.

Fig. 32 “Com” window

Select the radio button “Connect with Serial Port” if you want to connect with the PC to 
the VT-VRPD using the Serial Port connection.

With the “Serial Port“ entry field the user specifies which serial port of the PC is used 
to communicate with the controller card.

The “Timeout“ field is the delay for “Cable break” detection by BODAC. This value can 
be changed in Security Level 2.

Connect with Serial Port

Serial Port

Timeout
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Select the radio button “Use Modem to Connect” if you want to connect with the PC to 
the VT-VRPD remotely using a modem connection. 

With the “Modeml Port“ entry field the user specifies which serial port of the PC is 
used to communicate with the controller card using a modem connection.

The “Timeout“ field is the delay for “Cable break” detection by BODAC. This value 
should be at least 1500 ms.

The “Phone Number to Dial” field is used to enter the phone number of the remote 
modem.

AT commands are stringssent to the modem connected to the PC to configure it 
before dialing. There is a basic command set, the Hayes Command Set, that most 
modems have implemented (For more information refer to 
http://en.wikipedia.org/wiki/Hayes_command_set ).
For specific information regarding commands that are used in your modem please 
refer to the modem manufacturer documentation. At a minimum the modem codes 
should be set to numeric(ATV0) and the results codes should be set to 0(ATX0).

Opens a file with previously saved Modem Initialization Commands

Saves the Modem Initialization Commands listed in the window.

Fig. 33 Modem configuration 

In order to communicate successfully both the local and remote modems need to be 
configurated. The VRPD communicates at a defined baud rate; therefore the modem 
connected to the VRPD must be configured to communicate at the VRPD baud 
rate.Setting of the baud rate that matches the VT- VRPD baud rate can be achieved 
using dipswitches or AT commands depending on the modem being used (For details 
regarding setting of the modem baud rate please refer to the modem documentation)

Local Modem connection:

With an external modem a standard serial cable is used. The local modem must be 
set to return numeric results (Hayes Command ATV0) and basic results codes (Hayes 
Command ATX0). Depending on the modem used this can either be accomplished 
through dip switches on the modem or through the use of Hayes Commands. 

Use Modem to Connect

Modem Port 

Timeout

Phone Number to Dial

Modem Initialization Commands

Configuration of the modems
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Remote Modem connection:

The external remote modem must be able to answer incoming calls.The connection 
between the remote m odem and the VT-VRPD card must be a NULL modem cable.
The remote modem must be configured to auto answer an incoming call (Hayes 
Command ATS0=1 => sets auto answer to 1 ring). The remote modem DTR (Date 
Terminal Ready) should be set to override (Hayes Command AT&D0), because 
otherwise the modem will not answer since the VT-VRPD does not control the DTR 
line.

Signal Name DB-9 Pin  DB-9 pIN Signal Name

TD (Transmit Data) 3 - 2 RD

RD (Receive Data) 2 - 3 TD

SG (Signal Ground) 5 - 5 SG

It is recommended that a Winview recording is used when monitoring 
actual signals. The communication speed due to the modem connection 
is not fast enough to get the required resolution.

Establishing the connection using this method will take some. After the 
connection is established BODAC can be used as if there were a direct 
serial connection to the card although the communication rate is 
significantly lower.

NULL modem cable
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Options

The "Options" window defines the frequency and type of data transmission to the 
controller card.

Fig. 34 “Options, general” window

In this window, you can select, which monitoring routines are to be executed 
automatically by BODAC after a change of data.

WRITE TO CONTROLLER PROMPT: If settings or parameters were changed in 
BODAC without having been saved in the controller card, BODAC can show a 
corresponding warning window:
-  On closing the window, in which changes were made 
- On BODAC closing 

SET TO MEMORY PROMPT: When changed values are written to the controller, they 
are only saved in the volatile memory of the controller card. For permanent saving, the 
data must be set to the memory. Here, you can set, when BODAC saves the values 
automatically in the permanent memory of the controller card:
- Every write to controller.
- On form closing.
- On BODAC closing.

With the selection “Automatically write changes to the controller before setting to 
memory“, you make sure that the parameters changed by you in BODAC are 
transmitted before they are saved in the permanent mem ory of the controller.

If you deactivate these monitoring functions, you can nevertheless 
ensure that changed parameters are written to the controller card and 
saved in the permanent memory at least at the end of commissioning.

General
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Fig. 35 “Fault Monitoring, Options” window

The operator program BODAC queries at regular intervals the fault states of the 
controller card. This interval can be set here.

Fig. 36 “Options, Table Screen” window

Here, you can select the basic settings for the function “write table to controller“. 
When the “Table“ screen is closed before the tables were written to the controller, the 
tables are automatically written to the controller with this setting.

Fault Monitoring

Table Screen
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Fig. 37 Window "Optionen, MultiPlot"

Please select here the default line size of the MultiPlot in your Motion data display.

Fig. 38 Window  "Optionen, File Paths"

Here, you can determine the basic paths for saving parameter files and reading 
update files.

MultiPlot

File Paths
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Security

Five security levels are available for using BODAC. This allows the BODAC users to 
be divided into groups ensuring that only qualified and trained personnel can change 
critical settings.

The security levels are defined as follows:

Level 4 = Bosch Rexroth AG

Level 3 = Bosch Rexroth AG

Level 2 = Customer Default password “2“

Level 1 = Customer  Default password “1“

Level 0 = Customer

WARNING!

The restrictions for settings and changes to parameters and process 
data have been established for your own security!

Do not attempt through program manipulation or changes of any 
kind to defeat the security levels.

Personal injury and severe damage to components can result if 
the card no longer functions correctly due to improper 
intervention.
Such actions will also void any warranties and/or liability on the 
part of the manufacturer!

Please document the assigned passwords for yourself and your 
customers.

The BODAC software always starts up on Level 0.

A user can enter the password he has received for his user group in the “Login” 
window. After successfully logging in, any changes to settings and parameters 
allowed for this group can be made.

Fig. 39 “Login” window

Login
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In the “Passwords" window you assign the associated password of your choice to the 
defined security levels.

Fig. 40 “Passwords” window

If the BODAC software is in Level “2”, the following window opens. In this window you 
can assign a password for the display on the front panel of the controller card.

Fig. 41 “Passwords” Level 2 window

No changes can be made using the display or pushbuttons without knowledge of this 
password , only the set values can be displayed.

In the “Security : Configure screens” window you specify which user group is given
access to the various BODAC windows.

Passwords

Configure screens
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Fig. 42 “Security :Configure screens” window

You can use the fields assign security levels. In the “View” and “Set” column you 
determine which user group is permitted to open certain windows for viewing only or 
which is entitled to change parameters.

Utilities

Program changes (updates) from BODAC are in the form of files (SRecord Files) with
the suffixes:

.hcd

.jmt

.pkg

Click on the menu item “Upload firmware”, and in the resulting “Open” window you 
can select the update file. The BODAC program guides you through the following 
steps until the program changes are complete. This utility is only available when the 
USER is ONLINE with the controller.

Resets the values and parameters for the card to their factory default settings.

Upload firmware

Use Default Parameter Data
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WARNING!

When you reset the values and parameters to their defaults, all the 
current data will be lost!

5.6 Application Window menu

Fig. 43“Application Screens” menu

Structure

Configuring inputs and active components of the structure can be done in this window.

Clicking on the preceding icon, which is a component of the toolbar, 
also opens the “Structure” window. A list of existing shortcuts for the 
toolbar can be found in Section 4.2 “BODAC Toolbar”.

See also: Section 3.4 “Configure profiles”.

Command adjustment

In this window the command can be adjusted for the specific characteristics of the 
applied valve. 

Clicking on the preceding icon, which is a component of the toolbar, 
also opens the “Command Adjustment” window. A list of existing 
shortcuts for the toolbar can be found in Section 4.2 “BODAC 
Toolbar”.

See also: Section 3.6 “Valve configuration”.

Commands

Opens the "Commands“ window for parameterizing the command values.
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Clicking on the preceding icon, which is a component of the toolbar, 
also opens the “Command values” window. A list of existing shortcuts 
for the toolbar can be found in Section 4.2 “BODAC Toolbar”.

See also: Section 3.4 “Configure profiles”.

Digital I/O

Opens the window „Digital I/O“.

Clicking on the preceding symbol, which is a component of the 
toolbar, also opens the „Digital I/O“ window. A list of existing 
shortcuts for the toolbar can be found in Section 4.2 „BODAC
Toolbar“.

Fig. 44 Window „Digital I/O“

Defines under what conditions the Digital Outputs are set. DO1 – DO3 conditions are
pre-defined and can not be changed. DO4 – DO6 can be configured as follows:

OFF
The Digital Output is not active.

LVDT>=WINDOW
The actual value exceeds or is equal to a set value (WINDOW).

LVDT<=WINDOW
The actual value is less than or equal to a set value (WINDOW).

Ramp done
The Ramp is done.

Fault Analog Inputs
A fault concerning the analog inputs has been detected. If the user wants to use 
this condition to set an output the respons e of this fault has to be set to “Flag” in 
the “Fault” window. For detailed information on configuring the “Fault” window 
please see also Section 3.5 „Configure Profile”

Outputs
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ABS(LVDT)<=WINDOW
The spool is in the zero position. A tolerance for the zero position (here 
“WINDOW”) of the valve is needs to be configured.

Fault Status
The present fault is output as a combination of pulses. The output can be fed to 
an optional output DO1 to DO7 depending on the configuration.

Depending on the selection of the pull-down menu the entry fields „WINDOW“ and 
„Debounce” appear. “WINDOW” has to be configured with the value for the selected 
condition. “Debounce” has to be configured with the time the fault condition has to be 
present before the Digital Output is set.

The last column presents the opportunity to invert the signal.

Fault code Fault

1 Range error for analog input Al1.

2 Range error for analog input Al2.

3 Range error for analog input Al3.

4 Range error for analog input Al4.

5 Range error for analog input Al5.

6 Range error for analog input Al6.

7 Not used.

8 Not used.

9 LVDT secondary side.*

10 Not used.

13 Short Circ Solenoid.*

14 LVDT primary side.*

15 Not used.

16 Not used.

17 Error block timeout.

18 Not used.

19 Block error.

20 Control error Loop 1.

21 Control error Loop 2.

22 Not used.

23 Parameter file checksum error .

24 Not used.

25 24V supply voltage fault.

26 Reference voltage fault.

27 Fault short-circuit of digital output DO1.

28 Fault short-circuit of digital output OK.

29 Fault short-circuit of digital output DO2.

Fault Status 



Company Registered in England No: 4167649    VAT Registration No: 732 5692 25    BS EN ISO 9001:2008 No: LRQ 0964389

+44 (0)1204 699959
enquiries@hyquip.co.uk

Hyquip Limited   New Brunswick Street   Horwich   Bolton   Lancashire   BL6 7JB   UK

www.hyquip.co.uk/web/index

RE 30126-01-B/08.07 | Manual Hydraulics |  Bosch Rexroth AG 65/76

BODAC – Menu Description 5

30 Fault short-circuit of digital output DO3.

31 Fault short-circuit of digital output DO4.

32 Fault short-circuit of digital output DO5.

33 Fault short-circuit of digital output DO6.

34 Fault short-circuit of digital output DO7.

35 Fault, maximum frequency of incremental encoder 
exceeded.

36 Not used.

37 Bus fault, master not active (CANOpen, DeviceNet).

38 Not used.

39 Not used.

40 Not used.

41 Not used.

42 Not used.

43 Not used.

44 Not used.

45 Not used.

46 Not used.

47 Not used.

48 Cable break sol. A

49 Cable break sol. B

The fault code is issued as follows: 
Tens digits : A long pulse of 2 seconds
Ones digits: A short pulse of 0.5 seconds
The fault code is repeated after a break of 5 seconds.

The figure below shows fault code 18 (fault of SSI encoder cable).

Fig. 45 Example: Output of a fault code via a digital output
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If „Enable set OK“ is selected the „OK“ signal is high only when there are no Faults
and the Enable is high.

Motion Data

The “Motion Data” window shows the entire signal sequence of your control loop in 
real-time.

Clicking on the preceding icon, which is a component of the toolbar, 
also opens the “Process display” window. A list of existing shortcuts for 
the toolbar can be found in Section 4.2 “BODAC Toolbar”.

Fig. 46 “Motion Data” window

A detailed description on the Motion Data window is available in the section “Testing
the application settings „

The Menu file in the „Structure Summary“ window corresponds to the BODAC main 
window “File Menu“.

Takes you directly to the help function for the current topic, or to the contents page of 
the BODAC windows help.

Buttons are provided for frequently used functions. These are described in section 
“Toolbar“.

Clicking on the oscilloscope symbol in the toolbar opens the BODAC 
window “Multiplot”. For more detailed information see section 
“Multiplot”.

Inputs

Motion Data –
File menu

Motion Data –
Help menu

Motion Data –
Toolbar

Motion Data –
Toolbar



Company Registered in England No: 4167649    VAT Registration No: 732 5692 25    BS EN ISO 9001:2008 No: LRQ 0964389

+44 (0)1204 699959
enquiries@hyquip.co.uk

Hyquip Limited   New Brunswick Street   Horwich   Bolton   Lancashire   BL6 7JB   UK

www.hyquip.co.uk/web/index

RE 30126-01-B/08.07 | Manual Hydraulics |  Bosch Rexroth AG 67/76

BODAC – Menu Description 5

The Data Log symbol in the toolbar generates a file with the extension 
“.log” in which all motion data are stored.

Clicking on the preceding icon, which is part of the toolbar also opens 
the "WinView recording“ window.

Creating a log-file

To create a log-file in table form of all the signals in the „Motion Data“ window for a 
certain amount of time the following needs to be done: 

Click on the Data Log icon.

This will open an explorer window in which the user has to specify the file-path
and the filename of the log-file. Confirm the selection by clicking on „Save“.

A window will appear that will ask fort he duration of the logging. Please enter the 
log-time in seconds .

After confirmation by clicking the OK button the window will close. On the right 
side in the status bar of the “Motion Data” window the progress of the logging 
activity can be monitored.



Company Registered in England No: 4167649    VAT Registration No: 732 5692 25    BS EN ISO 9001:2008 No: LRQ 0964389

+44 (0)1204 699959
enquiries@hyquip.co.uk

Hyquip Limited   New Brunswick Street   Horwich   Bolton   Lancashire   BL6 7JB   UK

www.hyquip.co.uk/web/index

RE 30126-01-B/08.07 | Manual Hydraulics |  Bosch Rexroth AG 68/76

BODAC – Menu Description 5

The data is stored as a table in the log-file seperated by semicolon. There are multiple 
programs available on the market today that can import this format. In the following 
steps an import of the log-file into Microsoft Excel is explained:

In the “File” drop down menu click on „Open“. In the window that opens choose 
“All Files (*.*)“ for File of type. Select the log-file that has the recorded data.

A Text-import wizard will open. Select „Delimited“ in the Original Data Type 
section and click “Next”.

Select “Semicolon” as delimiter and click „Finish“.

The result is a table with all the signals of the “Motion Data” window. The first 
column is filled with an increasing number that represents the sample number 
and the second column has the tim e in seconds.

Multiplot

In the multiplot window the signal trace of selected signals are represented in 
graphical form. To open the “Motion Data Multiplot“ window, click the icon in the 
toolbar of the “Motion Data“ window“. The Motion Data Multiplot represents the 
signals, which you selected before in the Motion Data window with the mouse button.

Fig. 47 “Multiplot” window

The window is a convenient software representation of an oscilloscope. The signal 
display is a graphical representation of the signal over time.

Multiplot toolbar

The toobar contains buttons which you can click on to execute all the functions of the 
real-time oscilloscope.

Fig. 48 Multiplot – Toolbar
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Following is a list of the included functions:

Opens the “Save file as” window, in which you can save a signal plot 
as a file having the suffix “.plt”. The file can be loaded again as 
needed. You can also import the file in Excel.

Opens the “Open" window, in which you load a previously saved signal 
plot into the Multiplot window.

Opens the "Open new plot“ window.

Starts the logging process and display of the signal plot for the 
selected signals.

Stops logging of the signal plot and freezes the current display until the 
plot is activated again by clicking on the “Start” button.

Moves the signal display from right to left. The plot is dis played in 
scroll mode.

The signal display is fixed. The signal plot begins left and ends at the 
right border in constant repetition.

All selected signals are shown together in one signal display.

Each signal is shown in its own signal display.

Generates a screenshot of the current display of the multiplot window.
Opens the “Save file as” window, in which you can save the 
representation of the signal plot in a Windows Meta File (WMF file).
The file is then usable in virtually any common word processing or 
graphic program.

Opens the "Print“ window. You get a printout of the multiplot window.

Opens a window in which you can use two selection menus to add 
analog and digital signals to the display.

Opens a window in which you can delete a selected signal from the 
multiplot window.
You select a signal for deletion by clicking on its name in the “Signal 
display legend”. The signal is then highlighted with a white 
background. Non-selected signals are shown with a gray background.

Shows two cursors on the signal plot of the represented signals. When 
you select a signal in the “Signal display legend”, you can use the 
mouse or right/left arrow keys to go to the desired position of the signal 
plot.

The coordinates are shown in the “Signal display legend” as X- and Y-
coordinates.



Company Registered in England No: 4167649    VAT Registration No: 732 5692 25    BS EN ISO 9001:2008 No: LRQ 0964389

+44 (0)1204 699959
enquiries@hyquip.co.uk

Hyquip Limited   New Brunswick Street   Horwich   Bolton   Lancashire   BL6 7JB   UK

www.hyquip.co.uk/web/index

RE 30126-01-B/08.07 | Manual Hydraulics |  Bosch Rexroth AG 70/76

BODAC – Menu Description 5

Deletes the cursors for the X and Y coordinates from the signal 
display.

Opens a window in which you can set the start condition for displaying 
the signal plot. A selection menu is used to determine the signal for the 
start condition. In the “Trigger Units” entry field the value of the trigger 
parameter in units [Unit] is entered. This value is used to start the 
signal plot.

1 s/div

The signal display is shown in X- and Y-coordinates with green grid 
lines. The X-coordinate division can be changed by clicking on the 
preceding field. In the current representation the signal travels 1 
division in the X direction in one second.
To learn how to change the division of the Y-coordinate, refer to 
section "Multiplot signal display legend".

Increases the current Timebase setting with one step. If the current 
setting is 1s/div this function would increase the X-axis to 500ms/div.

Decreases the current Timebase setting with one step. If the current 
setting is 1s/div this function would decrease the X-axis to 2s/div

The user can zoom in on a selected area of the Multiplot window.

Reset the multiplot back to its original size.
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Multiplot signal display legend

The signal display legend shows the relevant information for the represented signals 
in tabular form.

Fig. 49 Real-time oscilloscope – Signal display – Legend

In the Parameters column the signals are shown with their names. Clicking on a signal 
name changes the background to white. This means the signal is selected.

Double-clicking on a signal name opens the “Adjust ” window.

Fig. 50 “Adjust graphs” window

In the “Adjust graphs” window you change the graphical display of the selected signal. 
Clicking on the "Color" field opens a color table from which you can select a new 
display color.

The “Thickness” field contains a selection menu for changing the line thickness of the 
signal.

In the “Min” and "Max" fields you enter the scaling in the Y-direction of the signal 
display for the selected signal.

The current parameter value is displayed in the signal display legend following the 
signal name.

The Color column is used for selecting the display color in order to ensure proper 
association and recognizability in the signal display.

The “X1” and “Y1” columns are directly related to the “Show cursor” button. If you 
move Cursor 1 to a certain place in the signal plot, you can read off the X/Y 
coordinates of the displayed signal in the X1/Y1 column.

In the “X2”/”Y2” column you read off the coordinates of Cursor 2.

The “dX” (delta X) and “dY” (delta Y) columns show the difference between the X and 
the Y values.

Parameters

Color

X1/Y1

X2/Y2

dX/dY
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Winview recording

Fig. 51 “Winview Recording” window

Corresponds to the BODAC main window “File Menu”

Takes you directly to help for the current topic or to the contents page of BODAC 
windows help.

Buttons are provided for frequently used functions. These are described in section 
“Toolbar“.

The designation of the signals corresponds to the representation in the BODAC 
Structure Editor, in which they are clearly represented on the basis of the input matrix, 
the block matrix, the loop matrix and the output matrix. 

Further information about the designation of signals that can be selected in BODAC 
can be found in the chapter “Structure Editor”.

Here, you can set the signal, which triggers the start of recording.

In this box you can set the conditions for signal recording. The number of points that 
can be recorded is limited to 16384. This is valid for the total of all signals. 
The record rate can be set within the range from 2ms to 32766ms. It is useful to select 
only record rates that can be divided by 2.
The PreTrigger Points can be adjusted within a range from 0 to 163844ms. If the 
trigger point occurs before the set pre-trigger points were recorded, fewer pre-trigger
points are shown on the signal display.

Winview recording –
File menu

Winview recording –
Help menu

Winview recording –
Toolbar

Trigger Setup

Recording Setup
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Faults

In this window you specify which error messages for the control circuit you want to 
output and log.

Clicking on the preceding icon, which is a component of the toolbar, 
also opens the “Faults” window. A list of existing shortcuts for the 
toolbar can be found in Section 4.2 “BODAC Toolbar”.

See also: Section 3.4 “Configure profiles”.

Test jacks

In the “Test jacks” window the signals can be assigned that are available for 
diagnostic purposes on test jack “X1” and “X2” on the front panel of the controller 
card.

Clicking on the preceding icon, which is a component of the toolbar, 
also opens the “Test points” window. A list of existing shortcuts for the 
toolbar can be found in Section 4.2 “BODAC Toolbar”.

See also: Section “Check Process Settings ”
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5.7 Windows menu

The Windows menu contains commands for saving and opening specified window 
layouts. Already opened windows can be directly selected here.

Fig. 52 “Windows” menu

When the BODAC is first started, only the main window is shown after loading the 
program. The “Save layout” function saves your current appearance of BODAC with 
all the currently opened windows and window positions in a file. This allows you to 
save preferred window combinations for working with BODAC and opening them at 
any time.

Select an opened window

Already opened windows (e.g., Structure, see Fig. 45 “Windows” menu) can be 
selected by a simple mouse click. This allows you to navigate quick and easy through 
opened windows.

Save layout

The “Save layout” function saves your current appearance of BODAC with all the 
currently opened windows and window positions in a file. This allows you to save 
preferred window combinations for working with BODAC and opening them at any 
time.

Open layout

Opens a window in which you can select files that contain saved layouts of BODAC. 
After opening the file BODAC recreates the saved window combination.
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5.8 Help menu

Online help for BODAC can be accessed as follows:
Press the F1 key.

or
Click on the Topics menu in the Help menu.

or
Click on the Help button in the active window.

Fig. 53 “Help” menu

In addition an informative text is displayed on the element you touch with your mouse.

About BODAC…

Information window which provides version information of BODAC.

Topics

Opens the overview of online help for BODAC, from which the user can navigate to 
any available topic.

Examples

Opens online help for the application (see section 3 " Application: 4WRE6 / 4WRE10
valve control").
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